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GeneMarker Manual

1 General Overview

1.1

1.1.1

B

Main Analysis Window

There are four major displays in the main analysis window.

Navigator; Sample File Tree

Electropherograms

Report; Report Table

Project Summary

See HELLPFUL ICONS INDEX for furthendetails,
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1.2 Navigator; Sample File Tree

1.2.1  This view lists all the samples that are included in the project. Prefixes LD, PC and NC
are labeling the allelic ladder, positive control and negative control

1.2.2  The sheet icon to the left of the sample name indicated the quality of the internal lane
standard (ILS) with the following color/code:

1.2.2.1 Green = High Lane Quality; Passing Size Standard -

1.2.2.2 Yellow = Requires Verification B

1.2.2.3 Red strike through = No Sizing@©ccurrence; failedrto call size 0l
1.2.2.4 Red Question Mark = one or more quality ¢fiteria are not met based on

the analysis parameters; See,Quality Reasons Index for more details.

1.3 Project Summary

1.3.1 This bar located at the bottom of theanain analysis screen summarizes the project as well
as alerts the analyst to samples,that did not'pass analysis parameters.

Mew 22 samples PC error il NC errofa/3 Ladder error: 0/1 #Failed=1 #Flagged=19
1.3.1.1 New reflects the data set is not a project that has been previously
analyzed.
1.3.1.2 Ifithe first column reads Modified, the project was previously analyzed

in the software.

1.3.13 The second column denotes the number of samples (including controls)
contained in the data set.

1.3:1:4 Columns 3-5 indicate the number of controls in the data set that do not
meet the quality criteria set in the software.

1.3.1.5 Column 6 denotes the number of samples that were disabled.

1.3.1.6 Column 7 denotes the overall number of samples, except the allelic
ladder, that do not meet the quality criteria set in the software.

1.3.2  NOTE: Flagging features are an indication of potential failures. The ultimate decision of
passing/failure is made by the analyst after further evaluation.

1.4 Calibration Chart Window
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1.4.1

There are three major displays in the calibration chart window.

1. Sample List
Size Standard Template
Sample ILS

I, Calibration Charts = =
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1.5  Sample List

1.5.1  This view lists all the samples that were processed in the project. The Score column
represents how well the size standard template and the sample ILS match. The closer the
score is to 100, the better the match. The sample may fail automatically if the size
standard is bad enough, or may have to be failed manually by the analyst.

1.6  Size Standard Template
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1.6.1  The template highlights all the peaks that should be labeled in the corresponding sample
ILS for easier comparison.

1.7 Samples ILS

1.7.1  The sample ILS displays the peaks that were detected. As well as the approximate start of
the data analysis view, indicated by the dash line.

1.8  Browse by All Color Window

1.8.1  There are four features in the Browse by All Color that allow forstraightforward review
of the sample.

Sample Drop-Down
Max Chart Number
Scroll Within a Sample
Scroll Between Samples
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1.9  Sample Drop-Down

1.9.1  The sample drop-down lists all the samples within a project. A user can move between
samples by clicking on the sample name instead of scrolling through all
electropherograms.

1.10 Max Chart Number

1.10.1 Max chart number views each sample by the number of dye lanes as per the user’s needs
during sample analysis.

1.11  Allele Labels

1.11.1  When analyzing samples in the Main Analysis windew«r the Browse by All Color
window, alleles may be colored yellow or red.

| THO | | p13s317 ||  D4EsS539 0l | D251338 |
160 180 200 220 240 260 \280 300y 0 320 340 360

A e NS

v g 3 15

175.0 21648 268.1 319.9

3316 [ 106 2942
=] 11 11 21
15249 2285 276 .2 3323
5396 503 TET4 Bo07

1.11.2 ‘Thisyundicates that one or more quality criteria have not been met in the software. See
Quality Reasons Index for more details.

1.11.3 NOTE: Flagging features are an indication of potential artifacts and/or allelic imbalance,
or peak saturation. The ultimate decision of passing/failure is made by the analyst after
further evaluation.

1.12 Peak Table

1.12.1  When analyzing samples in the Main Analysis window or the Browse by All Color
window, a peak table maybe added to supplement analysis by clicking Show Chart/Table

icon
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1.12.2  This table will indicate to an analyst which alleles were flagged and which quality reason
was triggereday See PEAK TABLE OPTIONS INDEX for further details.
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2 Load Data

2.1 To start your project, go to File — Open Data — Add
2.1.1  Navigate to the network folder containing the data files (i.e. the .fsa files) to be analyzed.
2.1.2  Select files to add (include only one ladder per project)
2.1.3  Hold Ctrl key to select multiple files
2.1.4  If analyzing all files hold Ctrl and A keys
2.1.5  Select Open
2.1.6 Ensure correct files are added to list

2.1.7 Deselect Auto-Elevate

(X

Open Data Files

File List:

ARUnEs D28 mistureztHun HST 2007-01-26 113033 Al fza Add »
SRunehlD28 migtresiRun_HS1_2007-01-26_ 113334 pe.fza
SRungslD28 migbores Run_HS1_2008-00-26 113435 ped.fza
MRun_HS1_2007-01-26_113436-_Buccal 2728 1-8bisa Femave
ARun_ HS1_[2007-01-26_11 3% 37aBuccal 2728 1-5c.fza

ARun HS1_2007-01-26_113%38_ Buccal_27-28 1-10afsa

WRun_HS51_2007-07-26_11339+ Buccal 27-28 1-10b.fza
SRtn_H51

i

0P -2F_11 35402 Buccal_27-28_1-10c fsa Rismave Al
YR un_HB1_ 2007012611387 -_Buccal_27-28_1-20a fea

WAun_HS1 2007-07-26_113442-_Buccal 27-28 1-20b.fsa

Data
M:h
M:A.
M:A.
A
M
[
M:A.
[
[ %
[
M

“Rur_HS1 2007-01-26_113443-_Buccal_27-28_1-20c.fsa

Add Folder...

=
T
o

=

4 y
H Cha &..| [ AutoElevate oK | Cancel |

2.1.8  Select OK

2.2 Ensure that prefixes LD, PC and NC are labeling the allelic ladder, positive control and
negative control, respectively, in the Sample File Tree.

2.2.1  Ifthey are not, right click on the sample name in the Sample File Tree — Set Sample
Type — Select appropriate sample type

2.2.2  Click Run Project located in the top toolbar.
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3 Run Wizard

3.1  In Template Selection window, select the appropriate existing template.

3.1.1 PowerPlex Fusion® LIZ - EVIDENCE

Template Mame: IFusiun

Panel: IFusiun_DCME_nu filter ;I Q
Size Standard: IILSEUU
Standard Color: IDH-{"-NGE
Analyziz Tope: IHlD

3.1.2 PowerPlex Fusion® LIZ - EXEM

Template

Analysiz Tope: |H|D ;I
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3.1.3 Yfiler® LIZ

Template Mame: |YFiIEr

Panelt |vfiler_OCME UL
Size Standerct [L1z_vfler =]
Standard Color: | ORANGE d
Analysis Type: [HID 4

3.2 Click Next
3.3 Inthe Data Process window, ensure the following settings,are used based on amplification kit.

3.3.1  PowerPlex Fusion® / PowerPlex Fusion® STRmix™

Run Wizard \ I\ ) IEI

Data Process - HIDAnalysis
Set data process options

Raw Data Analysis A y Allele Call
[v Auto R arge {frame) I&! [ Auta Range (bps]
M = 1000 5 st [55 2] End [510 4
I Smogth 1= Efihanced Smocth Peak Detection Threshold: ﬂ
Baseline SuS Q™ Min Intensity: [G0 =] Mar Intensiy: [32760 =

| | Jw,. Superior [ WClassic [ Enhanced

Percentage » |0 | Global Max

Mote: Use Panel Editor to set Min Intensity
and % Global Max for peaks within Markers

‘ [~ Pullup Carection v Spike Remaowval
| 4 Saturation Repair

Size Call
*" Local Southern " Cubic Spline

& save | << Back Cancel
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3.3.2  PowerPlex Fusion® EXEMPLARS
Run Wizard @
Data Process - HID Analysis
Set data process options
Fiaw Data Analysis Allele Call
v Auto Range [frame) m [ Auto Range (bps)
' = 10000 5 stat [55 3] End [5I0. 2] ‘
v Smooth [ Enhanced Smooth Peak Detection Threshold: _ﬂ ‘ '
sezalraBulblisd o Min Intensity: |50 .ﬂ Max Intensity; | 32760 .ﬂ
[ Superior [~ Clazsic [ Enhanced
Percentage » |10 '3] Globl M ax
[~ Pullup Comection [ Spike Removal
Saturation R epai . . .
[ Satuation Repai MNote: Use Fanel Editor toiget Mih Intensity
. andh2: Global Maxfor peakswithin Markers
Size Call
* Local Southern ™ Cubic Spline
n Save | %< Back ﬂext)) LCancel
333  Yfiler®
Run Wizard ' ‘ - @
Data Process,: HID Analysis
Set data prdces: options
Raw Data Bnalysis g Allele Call
| [ Auto Range [frame) m [ Auta Range [bps]
‘ Start: (2300 3, End |3000 & Chart |?5 ﬂ Bk |41D ﬂ
v Srigoth I™ Enhanced Smoath Peak Detection Threshald: ﬂ
e Min Irtensity: [ =] Max rtensity: [20000 =
[T \Superiar [ Claszic [ Enhanced
Percentage » |2 »| Global bax
[v "Pullup Comection v Spike Remaval
Saturation Fepai . . .
[ Satuation Repair MNote: Use Panel Editar to set Min Intensity
. and %z Glohal Max for peaks within Markers
Size Call
o Local Southern " Cubic 5pline
[ 5ave ‘ << Back | Mewt > | Cancel
34 Click Next
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3.5 Inthe Additional Settings window, ensure the following settings are used:

3.5.1 PowerPlex Fusion®/ PowerPlex Fusion® EXEMPLARS/ PowerPlex
Fusion® STRmix™

Run Wizard

Additional

Set additional

Pazitive Contral T

Peak Score:

Reject <

I~ Mixture Eval

Allele Evaluation & l

n Save | | << Back

=l

Settings - HID Analysis

optianz related ta the diferent analysis type I

Iv Auto Select Best Ladder ‘

L

emplate: [PP_Fusion | W Auto Paneldiustment

0.00 Check |1.00 < Pass

luation

Cancel

3.5.1.1

3.5.1.2

3513

3514

3.5 4.1

3.5.15

35.15.1

AllelicLadder: NONE is selected (grayed out, change not possible)
Auto Select Bést Ladder: Box is Checked
Auto PanelAdjustment: Box is Checked

Seleetsthe Positive Control Template using the Positive Control
dropdown:

For PowerPlex Fusion® - PP_Fusion
Allele Evaluation Peak Score: Reject 0.00 and Pass 1.00

Deselect Mixture Evaluation

Controlled versions of Department of Forensic Biology Manuals only exist in the Forensic Biology Qualtrax
software. All printed versions are non-controlled copies.

© NYC OFFICE OF CHIEF MEDICAL EXAMINER




FORENSIC BIOLOGY PROTOCOLS FOR FORENSIC STR ANALYSIS

GeneMarker Manual
Status:Published Document ID: 6311
DATE EFFECTIVE APPROVED BY PAGE
07/24/2017 Nuclear DNA Technical Leader 12 OF 33

352 Yfiler®

Run Wizard

Additional Settings - HID Analysis

Set additional options related to the different analpsiz lype

Allelic Lsder:

02-Allelic_Ladder_1_B01_003.fsa

Pozitive Control Template:

Yfiler MPC

—Allele Evaluation

Peak Score;

Reject < IEI.EIEI Check. |1.EIEI < Paz

1 Mixture Evaluation

" alid Mixture Peak Percentage; IEI %

Fir Mimture Marker Mumber: |3

Save

<< Back

Cancel |

own box.

Auto Panel Adjustment: Box is Checked

Auto Select Best Ladder: Box is Unchecked

Allelic Ladder: Select appropriate ladder for analysis from the drop

3.52.4 Select the Positive Control Template using the Positive Control
dropdown:
3.5.24.1 For Yfiler® - Yfiler MPC
3525 Allele Evaluation Peak Score: Reject 0.00 and Pass 1.00
3.5.2.6 Deselect Mixture Evaluation
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3.6

3.7

3.8

Note: Do NOT click Save within the Data Process Window. This will overwrite the template
for all analysts.

Click OK — Once data has finished processing Click OK

On the top left corner of the screen, Click File — Click Save Project — Navigate to desired
folder and save project using the naming system based on the instrument, date, injection
number(s), kit and analysis set (i.e. Newton090615 8-11U A)

4 Checking the Allelic Ladder

4.1.1  There are two areas in the Main Analysis window«that indi€ate if theallelic ladder used
for analysis has passed.

4.1.1.1 In the Sample File Tree, a red question matk next to the allelic ladder
would indicate a potentiallyafailed ladder.

4.1.1.2 In the Project Summary,a ladder error would indicate a potential failed
ladder.

4.1.2  Right click in the Sample FileTtee = Click Select Max. Open the Browse by All Color

Window icon < . Misually confirm all expected alleles in the allelic ladder are present.

4.1.3  Ifthe ladder used for analysis failed, click File from the menu bar - Click Open Data >
Highlight thefailed ladder from the Data File List = Click Remove - Click Add... >
Navigatedo the .fsa files = Select a different ladder for analysis = Click Open - Click

OK. Return to Section II. Load Data, step 2 and proceed.

5 Checkingithe Size Standard

5.1

52

53

[

Located on the top toolbar in the main analysis window, Click Size Calibration

In the Calibration Charts window, Click Chart Synchronize ~—

Click Sample Name header to sort samples in order. In the Sample List, either Click on a
Sample or Navigate using the Up/Down Arrows, check the size standard for each sample as per
the amplification kit.

5.3.1 If the peak is recognized by the software, a green inverted triangle appears at the top of

the peak. '
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54

5.5

5.6

5.7

5.8

5.3.2  If the size standard needs manual editing by adding or deleting a peak; Right Click on the
desired peak — Select Delete/Add Peak — Right Click Again — Select Update
Calibration

Close Calibration Charts window.

5.4.1  If any sample is automatically marked as disabled by the software, review the size
standard in the Calibration Charts window to ensure this was dueo failing or poor size
standard. If it is confirmed that the sample has a failing or poor size standard, a rerun
code must be applied to that sample. Right click on the sample,in Sample File Tree
within Main Analysis Window > Click Edit Comments - Enter rerun code in
Comments field = Click OK

5.4.2  If any sample has failing or poor size standard, and wasmot automatically marked as
disabled by the software, any peak labels presentimust be'deleted. Open the Browse by
All Color analysis window = navigate to_the relevant sample(s) = highlight all peaks in
one dye by holding down Ctrl, left click and'dragging around any peaks present in that
dye = click Delete to remove the peak labels—> repeat for cach dye. Right click on the
sample in Sample File Tree withint Main Analysis Window = Click Edit Comments >
Enter rerun code in Comments field = Click, OK

In the Main Analysis window, Click on'the Down Arrow next to the Show Color o icon located
in the top toolbar. — Click Hide All

In the Sample File Tree, Right Click on Allele Call —Click Select Max

In the Main Analysis window, Click on the Down Arrow next to the Show Color o icon located
in the top toolbar. = Click ORANGE

Adjust axisite,view size standard depending on amplification kit

Y,

5.8.1 Onthe top toolbar, Click Set Axis icon

5.8.2  Click Fixed ‘X > — enter X axis range
5.8.2.1 PowerPlex Fusion® = 55-510
5.8.2.2 Yfiler® = 75-410

5.8.3  Click Set Axis again — Select Auto Fit Y
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T

5.8.4  Note: Analysts can zoom in/out by using the zoom icons N located at the top
toolbar. As an additional option, hold down the left button on the mouse and drag the
dotted box that appears from the upper left to the lower right (around the desired “zoom
in” area). To zoom out, hold down the left button on the mouse again dragging the box
from lower right to upper left. To scroll while zoomed in, right click and hold while
dragging the mouse in the direction you want to scroll.

5.9  Review size fragments by ensuring that all required peaks are labeled within +/- 0:5bp of the
fragment size.

5.9.1 If a peak is not labeled, then the size standard fails.

5.10 Right click on sample in Sample File Tree within Main AnalysiséWindows=> Click Edit
Comments = Enter rerun code in Comments field 2 Click OK

5.11 If any sample with failing or poor size standard has‘peaks called, the peak labels of those peaks
will need to be deleted.

5.11.1 Open the Browse by All Color analysis window —> navigate to the relevant sample(s) >
highlight all peaks in one dye by holding,down Ctrl, left click and dragging around any
peaks present in that dye = clickdDelete toremove the peak labels—> repeat for each dye

6 Size Standard

6.1 PowerPlex Fusion®

6.1.1  PowerPlex Fusion®gsamples are run with the WEN ILS500. ILS500 has a range of 60-
500bp (Fragments: 60, 65, 80, 100, 120, 140, 160, 180, 200, 225, 250, 275, 300, 325,
350, 375, 400,425, 450, 475, 500). All size fragments must be labeled in the calibration
chart and,the orange dye lane.

6065 30 100 120 140 180 130 200 225 250 275 300 325 350 375 400 425 450 475 500

200 |

600 | T v ¥ L 4 ¥
400 | Yy ¥ Yy v v Y v v v v 75 7 vy v Y

200 |

o] |

2,500 3.000 3.500 4,000 4,500 5.000 £.500 6,000 6,500 7.000 7.500 8,000

6.2 Yfiler ®

6.2.1  Yfiler® samples are run with LIZ 500. The LIZ_Yfiler size template for LIZ 500 does
not have the 250 bp sizing peak labeled as it is not utilized for data sizing. This peak
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6.2.2

should not be labeled within the Calibration Chart window. All other size calls in the
range of 75-400 bp peaks must be properly match scored/sized

When viewing the size standard in the orange dye lane in the Browse by All Color, the
250bp will be labeled. This peak is not being used for sizing.

100 139 150 160 200 300 340 350 400

6,000

4,000

2,000

¥y v 7 T ¥ LI v
v

2,400 2600 2,800 3,000 3,200 3,400 3,800 3,800 4000 4200 4400 4600 4800 5000 5200 5400 6000 5800 6,000 B2000 6400 UE600 6800 7,000

7 Analyzing Samples

7.1

7.2

7.3

7.4

7.5

Analysis of the data can be performed in the MaimpAnalysis window and/or the Browse by All
Color EZ window.

Adjust axis to view samples depending on amplification kit

7.2.1

7.2.2

7.23

7.2.4

&
On the top toolbar, Click Set Axisdcon %
Click Fixed ‘X > —genter X axis range
7.2.2.1 PowerPlex Fusion® = 60-510
7.2.2.2 Yfiler®="90-340
Click Set'Axds again — Select Auto Fit Y
Note: Analysts can zoom in/out by using the zoom icons located at the top
toolbar. As an additional option, hold down the left button on the mouse and drag the
dotted box that appears from the upper left to the lower right (around the desired “zoom
in” area). To zoom out, hold down the left button on the mouse again dragging box from

lower right to upper left. To scroll while zoomed in, right click and hold while dragging
the mouse in the direction you want to scroll.

If using the Browse by All Color window, adjust Max Chart Number to 2

Analyst may choose to use the Peak Table E

during analysis. Click the = jcon to turn the

chart/table on and off.

Editing a peak
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7.5.1 Click on Peak to Highlight — Right Click— Click Edit Comments— Select Edit From
List or Type New Edit (refer to edit code list) — Click OK.

7.5.2  To select multiple peaks for editing, Hold the Ctrl key + left mouse click — Drag the
mouse to highlight intermittent peaks

7.5.3  Once the correct Edit is selected, highlight the peak and press Delete key to remove the
label from the peak.

7.5.4  To check peak history = Right click on peak = Click view history
7.5.4.1 Any changes made to the peak will bé'listed in order from most recent

down. Click on any line to view specific change details in the
Current/Old Values: window. Serollallthe way 10 the right to view edit
code applied to peak in Allele Commentsicolumn.

7.5.5  Note: Ifalabel has been removed from a‘peak and meeds to be restored, Click on Peak
to Highlight — Right Click—Undelete: If an editineeds to be removed from a peak >
right click on peak = click edit comments=> remove text from Comments: box so the
text field is blank = Click OK (the E will stillbe visible but the edit comment will be
removed)

7.5.6  Note: Peaks will only'be considered stutter by the software if they are within 0.5bp from

the parent peak. If a stutter peak is=>0.5bp from the parent peak the software will not
automatically filter this out as stutter, even if is under the stutter filter percentage for that
location. +/- 4 stutter'should not be manually edited from evidence samples in Fusion.
Stutter < 30% of the parentipeak can be edited from Fusion positive control samples and
exemplar samplegs..

7.6  Scheduling Re-Runs

7.6.1

If a sample Failed (over saturation, bad size standard, no data, etc..) = Right click on
sample in Sample Tree within Main Analysis Window = Click Edit Comments -
Type Re-Run Code in the comment box = Click OK

7.6.1.1 All peak labels must be removed from failed samples.

7.6.1.1.1 Open the Browse by All Color analysis window = navigate to the
relevant sample(s) = highlight all peaks in one dye by holding
down Citrl, left click and dragging around any peaks present in
that dye > click Delete to remove the peak labels—> repeat for
each dye
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7.6.1.2 If sample did not fail but re-run is desired = Right click on sample in

Sample Tree within Main Analysis Window = Click Edit Comments
- Type Re-Run Code in the comment box = Click OK

7.7  Over- Saturation
7.7.1  Check for saturated samples >
7.7.1.1 In the Main Analysis Window electropherogram a pink‘line will indicate

the possible saturation of peak. This indication,will also be noted in the
Peak Table as <SAT> for that allele inthe Allele\Comment field.

7.7.1.2 If the sample has excessively saturated peaks (>10,000 RFU or split
peaks) this sample must be reruniat a‘didution.
06-2ng_DNAZc_F01 011.fsa (06-2ng DNAZC) (RefLadder: 08-Alelic Ladder_1 HO 015.fsa) W 3
| Das117e |
| THO1 |
| 0165539 |
AMEL
76 78 80 82 B4 86
5,000 ]
4,000
3,000 ]
2,000}
1,000
u _- —
4754
7
522
5086
80.0
50.0
209
Mo. | File Name Size Heighll | Allele Quality Allele Comments Sample Comments Qui «
1 06-2ng_DNAZ_F... 78.9 4754f X [<5AT>] 5D
06-Zng_DMAZc_F... 1247 3879 ) 16 Pass

7.8 Once the entire run has been reviewed, all edits have been made and labels have been removed
from all edited peaks, on the top left corner of the screen, Click File — Click Save Project

7.9  You must save over the existing project every time you save.
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8 Exporting for LIMS (all systems and sample types)

8.1 In the Main Analysis Window > Click the down arrow next to the Show All Color icon = Click
Show All to turn on all colors before exporting.

8.2  Inthe report display section of the main analysis screen, click on the down arrow next to the Save

Report icon

" . Ensure the “Save LIMS report” is selected.

8.2.1 In the LIMS report settings window that pops up, ensurethe settings are as follows:

8.2.1.1

8.2.1.2

8.2.1.1.1 90-340 for Yfiler

8.2.1.1.2 60-510 for Fusiom:

[ LIMS Report Settings

Dyes

[v BLLE v REQ

[+ GREEMN [amiiy - 1§
[v TELLOW

[v' Shiow File Mame
TS hiowl S ampleabbarne

| [v ShowDeleted Peaks
[ Hide,E xtra Sample Mames

[ Exclude Report Header

Ok

. U

|-I:I|:|ti|:|n$-
4 Size Range(bps}

From |55 to 510
| [ Abide By Panel
[T Grouped By Markers

Colurmns. .

W s [

[ Show Only Uncertain Alleles

[v Show Rejected Low Scare Allsles

Cancel

The Size Range will be the same as(the X- aXis rangefor analysis:

In Options, click on “Columns...”; use the Add/Remove buttons to

ensure the Selected Columns are present and listed in the order that

follows:
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Selected Columnz

Plate 1D

b arker

Dye

Size

Allele

Allele Cormments
Sample Comments

8.2.1.2.1 This is crucial to proper LIMS importation.

8.3  Click OK; Click OK again in the Allele Report Settings window. Save, the file ds type “Excel File
(* xIsx;*.x1s)” under the appropriate run name (make sure toideleté suffix “ AlleleReport™).

8.4  Navigate to the data entry screen for the corresponding test batch'in,LIMS. Click Import
Instrument Data and import the excel file for the,project.

9 Exporting Electropherograms (alLsystem and sample types)

9.1  Inthe main analysis window,

9.1.1  Click Set Axis = Click Fixed X axis The Size Range will be the same as the X- axis
range for analysis:

9.1.1.1 60-510 for Fusion
9.1.1.2 90-340 for Yfiler
9.1.2 Select Auto Fit Y

9.2  Click Tools—> Expert Electropherogram

9.3 Set Output Folder to desired location for project PDFs by clicking T icon

Export Electropherograms @

Output Folder;  |M:5STR_Datahia_QC\Athenah 207 E6h\Athena031416_10-11_2016-03-14%
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94

9.5

9.6

9.7

9.8

9.9

Ensure settings match below:

9.4.1 Make sure to select PDF as export format

Select Dyes

v BLUE

v GREEM

v YELLOW

¥ RED
ORANGE

Dye Image Size

Width: | 1024 pirels
Height: |700 pirels

[~ Oreimage per zample
[v Auto Scale Size Range
[ &uto Scale Marker Intenzity l

Ewpart Format: IF‘DF fila =

9.4.2  In the suffix field entef'the' run name with a “ ” before it. (Ex: Newton061316 88-89U
A)

Printing the ladder: Right click in the sample list = click Deselect All = Check the box for the
ladder = In prefix field enter ladders” - click Export

Printing the contrels: Uncheckithe box for the ladder and check the box for all controls in the run
- In the prefix field enter controls_ = click Export

Printing the samples: Right click in the sample list = click Select All = Uncheck the box for all
ladders and controls in the run, leaving all samples selected = clear the prefix field = click

Export. This will create 4 PDFs for every sample, one for each dye.

If analyzing Evidence:Wait to import PDFs into LIMS until after the completion of STRmix
analysis.

If analyzing Exemplars: Import all PDFs into LIMS.
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10 Fusion Exemplars Only - Exporting EXEMPLAR table for STRmix™™

input (for evidence table instructions see Section 11)

10.1 In Main Analysis Window Click the " icon > Select Show AlL. In the report display section

ﬁ' !
of the main analysis screen, click on the report settings icon . Mak€ sure settings match
below:

Allele Report Settings I o @

Report Style Optiors D
" Allele List [v Extend Diploid Homazygous
(¥ Fu:urensu:a [v Show Allele Mamme
" Bin Tahle WS how Szl bps)
(" Peak Table v Shain Height
£ Allele Count |~ Show Ares
= [ Show Scare

[v Show File M ame

N Show [~
[ Show Sample M ame ]
_ . N L [ Show Only Uncertain Alleles
Drieggfor _ [v Show Rejected Low Scaore Alleles
& Harizontal {* “ertical

[ Hide Extra Sample Mames

[ ExcludeSample Index [ E=clude Report Header

ok Cancel

10.2  In the report display section of the main analysis screen, click on the down arrow next to the Save

Report icon " . Ensure the “Save Report” is selected.

10.3 Navigate to appropriate folder and save file as “Run name SM”

10.4  For proper STRmix™ import the GeneMarker® to STRmix™ macro needs to be run.
10.4.1 Open the exported project excel file from Step 10.3 above.

10.4.2  Open GeneMarker® to STRmix™ macro.
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10.4.3 Follow the instructions on the “instructions” tab.
10.4.4  After macro has run click “save as” within the GeneMarker® to STRmix™ macro file.
10.4.5 Change the file type to “.txt” (text, tab delimited)

10.4.6  Navigate to folder containing your project data and save file there.

11 Fusion Evidence Only - STRmix™ Analysis (stutter filfers off)

11.1 Begin by importing the data from the initial analysis into LIMS to generate the edit sheet. Have
the edit sheet open in LIMS as you perform the second analysis withfstutter filters off for
STRmix™ to refer to and ensure the same edits are being‘madeithe seconddtime.

11.1.1  If Project is still open = Click Run Project — " located in'the top toolbar.

11.1.2  If project is not open = Click File - "Open Projeet = Navigate to run > select project

b

= click open = Click Run Project “&. located in the top toolbar.

11.2  In Template Selection window, selectthe @ppropriate existing template.

Template Mame: |Fusiu:nn_5TRmix

Panet™{Fusion_OCME_5TRmix_Mo | L | g
Size Standard: |IL55EIIZI ﬂw

Standard Color: | ORAMGE ﬂ

Analyziz Type: |H|[:| J

11.3  Click Next
11.4 In the Data Process window, ensure the following settings are used based on amplification kit.

11.4.1 PowerPlex Fusion® STRmix™
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[ Run Wizard @ﬁ

Data Process - HID Analysis

Set data process ophions

Raw Data Analysis Allele Call
[v &uta Range (franme) 1~ [~ Auto Range (bps]
b= 10000 stat: [55 3] End 810 3
v Smoth [ Enhanced Smooth Peak Detection Threzhold: :J

Eesditblelon: bin [ntenzity: (50 ﬂvv b ax Intenzite I32?ED =

Iv Superior | Clazszic [ Enhanced
) ] Percertage » |0 =1 Global Max
| Pullup Corection v Spike Removal

Saturation Repai : . .
[ Saturetion Repai Mote: Use Panel Editortgysgt bin Intensity

and@@Global Max for peaks within Markers

Size Call
fo' Local Southern " Cubic Spline
B save | | Cancel
11.4.1.1 Click Next
11.4.1.2 In the, Additional Settings window, ensure the following settings are
used.
11.4.1.2.1 Make sure Auto Select Best Ladder is selected
bl.4.1.2.2 Auto Panel Adjustment: Box is checked
1144.1.2.3 Select the Positive Control Template using the Positive Control
drop-down.
11.4.1.2.3.1 For PowerPlex Fusion® PP_Fusion
11.4.1.24 Under Allele Evalution Peak Score, Reject 0.00 and Pass 1.00
11.4.1.2.5 Deselect Mixture Evaluation

11.4.2 Note: Do NOT click Save within the Data Process Window. This will overwrite the
template for all analysts.

11.43 Click OK > A window will pop up:
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Use Old Calibration 3]

& Size Calibration

The internal lane sizes hawve been calibrated in the samples.
“rou may check Call Size Again to recall the sizes.

¥hat to do:

Apphy to Al | Apply to Cument l

11.44 Check “Call size again” and Click Applyto,All - ‘Allow data to process — Click OK

11.4.5 On the top left corner of the screen, ClickiFile — Click Save Project = Save Project with
suffix SM

11.4.6  Perform a second analysis of this ztin

11.4.6.1 Dogot recheck or edit Ladder, Size Standard or Controls. Passing
controls and size standard are determined by the initial analysis.

11.4.6.2 In Sample Trée - Right click and disable every control in the project
except the Ladder. Enter Comment “Not Used”

11.4.6.3 Ensure any samples that failed initial analysis are disabled.

11.4.6.4 Remove the labels from the same peaks that were edited in the initial

analysis. It is not necessary to enter edit codes again.

11.4.6.5 If a sample had a rerun code during the initial analysis it is NOT
necessary to enter the rerun code again.

11.4.7 Once the entire run has been reviewed, and labels have been removed from all artifact
peaks, Click File — Click Save Project
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12 Fusion Evidence Only - Exporting Electropherograms after STRmix™

Analysis (samples only)

12.1.1  In the main analysis window, set the fixed X axis to60-510 and set the Y axis to Auto Fit
Y.

12.1.2  Click Tools> Export Electropherogram

12.1.3  Set Output Folder to the same location where the PDFsdfor the'initial Fusion analysis of

the same project were saved by clicking J icon

Export Electropherograms ‘ ‘ I @

Cutput Falder: | MASTR_Data\a_0ChAthena\ 201 BNAthena09T41601.0-11 S201 6-03-14% o

12.1.4  Ensure settings match below:

Select Dpez

| BLLE

¥| GREEM
| YELLDY
v REQD
e@RAMGE

Dye Image Size

Wwhidth: 1024 pirels

Height: | 700 pizels

[ Oneimage per zample
[v Auto Scale Size Range
[ Auto Scale Marker Intensity

Ewport Format: |POF file -
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12.1.5 In the suffix field enter the run name with a “ ” before it followed by SM (Ex:

_Newton061316 88-89U A_SM) to indicate STRmix™ analysis.

12.1.6  Printing the samples only: Right click in the sample list = click Select All - Uncheck
the box for all ladders and controls in the run and any samples that were disabled or
failed, leaving only the passing samples = clear the prefix field = click Export. This
will create 4 PDF's for every sample, one for each dye.

12.1.7 Import all PDFs (initial Fusion analysis and STRmix analysis) at the same, time into

LIMS.

13 Fusion Evidence Only - Exporting EVIDENCE table for STRmix™ input

13.1.1 In the report display section of the main analysis'sereen, €lick.on the report settings icon

CEY .
. Make sure settings match below:

aN\N T =

[ ptigms

Allele Report Settings

Report Style
" Allele List

| v Extend Diploid Homaozygous

| | [v Show Allele M ame

" Bin Table
" PeakeTakle

{ £Allele Caunt

| | [v Show Eil= Mame
= Shiow Sample Marme

Orientatiar

" Harizontal f* ‘Wertical

[ Exchude Sample Index

v Show Size [0.1bps)
[v Show Height

[ Show drea

[ Show Score

= s [

[ Show Only Uncertain Alleles

[v Show Rejected Low Scaore Alleles

[ Hide Extra Sample Mames
[ Ewclude Report Header

Cancel

13.1.2 Click OK
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13.1.3 In the report display section of the main analysis screen, click on the arrow of the Save
Report icon = - .
13.1.4 Click Save Report.

13.1.5 Navigate to appropriate folder and save file as type “Excel File (*.xIsx;*.x1s)” under the
appropriate run name (make sure to delete suffix “_AlleleReport”)«€lick Save.

13.1.6  For proper STRmix™ import the GeneMarker® to STRmix™ macro needs to be run.

13.1.6.1 Open the exported project excel file from Step 13.h.5 above.

13.1.6.2 Open GeneMarker® to STRmix* magrof

13.1.6.3 Follow the instructions on the “instructions’’tab.

13.1.6.4 After macro has run élick “saveéas within the GeneMarker® to
STRmix™ macrofile.

13.1.6.5 Change the file typeto “.txt™*(Text, tab delimited)

13.1.6.6 Navigatesto folder containing your project data and save file there.

14 Reporting Analyst/Case Tech Reviewer Sample Review

14.1.1 Verify alldlSTR runs associated with case file samples checking for:

14.1.1.1 Passing Allelic Ladder was used to analyze run

141002 Passing controls were present

14,1413 Passing Size Standard for relevant case file samples

14.1:0.4 Appropriate edits were made for relevant case file samples and labels

were removed from edited peaks
14.1.1.5 Any relevant samples needing re-run were scheduled and/or disabled
14.1.2  Determine if sample is suitable for comparison/STRmix™ analysis
14.1.3 Ifatrue OL/OB was detected in a sample the allele must be assigned a call for STRmix™

14.1.3.1 Open STRmix™ .txt input file and replace OL/OB call with true call.
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15 HELPFUL ICONS INDEX

15.1 Main Toolbar Icons

‘ Icon Name Function
Run . .
> Project Opens Run Wizard for processing the data.
Show/Hide | Allows user to show/hide the frames for the Sample File Tree, Synthetic
7 B B Toggles Gel Image and Report Table, respectively.
Show Allows user the choice of'viewing/hiding all color lanes or single dye
— Col lane layer (with singledeft mouse click on the icon, obtain single dye
e - olor view)
Zoom Allows for more discriminate view of electropherogram. Alternately,
In/Zoom hoeld down left mouse button and draw a box; dragging from top left
@ e Out corner to bottom right zooms in on image while dragging from bottom
L right corner to top left zooms out.
Default sets Y-axis by maximum peak intensity for the sample
Set Axis displayed. The other 2 options either auto-fit the Y-axis by the peak
El'( intensity of the alleles displayed, or allow for setting the X- and Y- axes
ranges manually.
Browse b Allows for comparative view display of sample electropherograms by
All Color}sl dye color. Individual samples can be selected from the drop down menu
g in the upper right corner of the All Color Browser display window.
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15.2 Allele Call Icons available after raw data processing only; Sample File Tree Allele Call folder must be selected

‘ Icon Name Function
Size Displays calibration charts for linearity of lane analysis
Calibration '
Show Allows user to toggle the display toshow only thewPeak Table, the Peak
Chart/Table | Table and the Electropherogramgor just the’Electropherogram.
Save Peak | Allows user to export the'Peak Table as an Excel(.xls) file or a tab-
Table delimited Text (.txt) file.
v
Allowsuser t0 call alleles by sample(s), by marker or by dyes. Allows
Call Allele |45 to make some modifications to the threshold/filter settings without
having to activate Run Wizard again (i.e. Peak Detection Threshold,
A . Stutter Peak Filter and Peak Score Threshold).
Marker; |-None- v Markey Allows user to select a marker to view. Available after the samples have
Drop-down b
ecn compared to a Panel.
Menu
€ . . .
Event Log | Displays the processing success/failure of each dye lane.
=l \i’/lligi‘cd Activates the Start Your Project, Run and/or Report dialog boxes.
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15.3 Browse By All Colors Icons
| Icon | Name Function

® 0 Zoom

A In/Zoom | Same use as in the Main Analysis Screen.

Out
Show/Hide Allows user the option to show/hide X*and Y- axis grid lines that
: Mouse . . ..
~ Cross appear at the tip of the mouSse cursor alqng with the basepair size
. and RFU value of the moéuse cursor position.
Lines
-(\..- Sho]vgvi/ll:llde Allows userthe,option te\show/hide the Bin brackets at the top and
- bottom ofithe electropherogram.
Ranges

—1 Allowsduser the option to adjust the RFU intensities of low peaks to

| AN Auto Scale |‘matehthe intensity of the highest peak in the dye color. When low
O Marckersy | peaks are increased, the intensity magnification factor is noted in

the matker (can adjust from 2X to 8X).
é . Opens the Print Report settings box. Also accessible in the Main
Print .
Analysis screen.
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15.4 Report Table Icons located directly above the Report Table.

‘ Icon Name Description
Report Allows user to customize Report Table display settings.
Settings

] Save Allows user to export the Report Tablé as an Excel(.xls)Afile or tab-
— Report delimited Text (.txt) file.
Cus]t;;lrlnlze Allows user to select which,bins to include/exclude in the Report Table
_ Column (check with TSL aS'this is notaceessible at this time)
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16 PEAK TABLE OPTIONS INDEX

Dye dye lane location of peak
Size peak basepair size (x-axis)
Height value given as relative frequency units (RFU) of the peak (y-axis)
Height Ratio peak height divided by height of highest peak in the dye lafie or
Marker
indicates the area under the curve of the peak; calculated based on x-
Area . .
axis Start/End column settings
Area Ratio peak area divided by area of highest peak in the dye lane or Marker
Marker locus location of the peak
bin location of the peak (based on kit/system panel and ladder analysis
Allele .
of project)
. absolute value of distance between the peak eenter and Bin center in
Difference .
basepairs
assigns Pass/Check/Undeterminediqualitypranking for each peak
Quality relative to the Allele Evaluationf/Peak,Score settings in the Run
Wizard (see Additional Settings)
an exponential cufve based evaluation of the peak; calculation of the
Score value is based on signal-to-noiseratio and peak shape (or
morphology)
Start/End beginningrand finish basepairs of the peak's Area calculation
Allele software and user edited comments for the peak; right mouse click
Comments peakiin chatttoradd,peak edit comments or select from the drop down
list (mote in Edit Comments Index)
user added'comments for the sample; right mouse click sample name
Sample T 5 ! dd le ed; lect from th
Comments inthe,samp ? tree to q new sample edit comments or select from the
drop down list (more in Sample Comments Index)
Quality letter code abbreviation(s) of reason(s) for a peak 's Quality
Reasons assignment if ranked Check/Undetermined
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